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RTx Release Notes 

1 Introduction 

1.1 Purpose 

The purpose of these Release Notes is to: 

 Communicate any known limitations for the RTx release. 

 Provide information on certain product features. 

1.2 Scope 

The scope of these Release Notes is Mirada’s RTx 1.6 product 

1.3 Disclaimer of Warranty 

Mirada Medical makes no representations or warranties, either expressed or implied, by or 
with respect to anything in this document, and shall not be liable for any implied warranties of 
merchantability or fitness for a particular purpose or for any indirect, special or consequential 
damages.  

Copyright © 2014, Mirada Medical. 
All rights reserved. 

GOVERNMENT RIGHTS LEGEND: Use, duplication or disclosure by the U.S. Government is 
subject to restrictions set forth in the applicable Mirada Medical license agreement and as 
provided in DFARS 227.7202-1(a) and 227.7202-3(a) (1995), DFARS 252.227-7013(c)(1)(ii) (Oct 
1988), FAR 12.212(a) (1995), FAR 52.227-19, or FAR 52.227-14, as applicable. 

References to other companies and their products use trademarks owned by the respective 
companies and are for reference purpose only. 

1.4 Definitions 

Term Definition 

AC Attenuation Corrected 

DICOM Digital Images and Communication in Medicine. 

NAC Non Attenuation Corrected 

PACS Picture Archiving and Communication System 

ROI Region of Interest 

SCP Service Class provider (DICOM node to receive DICOM data) 
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2 RTx 1.6 Release Notes 

2.1 Known Limitations 

2.1.1 RT-1584 Markers and isocenter statistics are not included in Export Region 
Statistics 

It is not possible to export statistics for markers or isocenters. 

When exporting region statistics via the ‘File->Export Region Statistics’ menu, markers and 
isocenters appear in the list of items to be exported but these will not be written to the file.  

2.1.2 RT-1600 Configuration required on upgrading quick steps 

A number of quick steps have new options added in RTx 1.6. 

For customers upgrading to this version, this will require any of the following quick steps to 
have their configuration edited before they can be used: 

 Dose summation quick steps need to have values set for the ‘Dose sum start’ and 
‘Dose sum end’ options. 

 ITV generation quick steps need to have the option for ‘Generate intermediate results’ 
modified. 

Information on editing quick steps can be found in the help guide. 

2.1.3 RT-1571 Missing Structure from Atlas Contouring 

If the results of running atlas contouring would lead to a structure with no contours, the 
resultant empty structure is discarded. 

In this case the structure should be created manually. 

2.1.4 RT-1445 Export Region Statistics stops after raising a warning message 

When exporting region statistics for a very large region of interest (greater than one million 
voxels), a warning will be displayed that the generated file will be too large and no further 
data will be written. This means that any regions after the one that generated the warning will 
need to have the statistics re-exported. 

2.1.5 RT-1569 Export RTSS option available after placing an Isocenter 

It is possible to display the export RTSS screen when an isocenter is present with no contoured 
structures. The isocenter will not be displayed on the export RTSS screen for selection. 
Isocenters cannot be exported to RTSS as isocenters, however, they can be exported to RTSS 
as markers.  
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2.1.6 RT-1537 TLG units are not formatted as expected 

Depending on the volume quantification units set in Tools>Options, some derived statistics 
may be displayed in units that are correct, but somewhat unconventional. E.g. cm5 / ml rather 
than cm2. 

This will be changed in a future version of the software. 

2.1.7 RT-1001 Undo/ Redo while on the report page 

The undo and redo feature is not aware of the screen currently displayed or the feature 
currently being used. This means that it is possible to undo actions for which there may be no 
immediately visible results. 

A tooltip of the action to be undone/redone is displayed when the mouse is hovered over the 
undo or redo button on the toolbar. This should be checked before undoing or redoing an 
action. 

2.1.8 RT-1410 Truncation when tools added in the structures panel toolbar 

Items can be added to the Structures panel toolbar in the Toolbox. If too many items are 
added, the Structures panel will become truncated and it will not be possible to access items 
at the right hand side.  

2.1.9 RT-817 Upgrading layouts from 1.0 to 1.6 where RT Dose roles have changed 

In order to provide a consistent user experience across the review modes of RTx, some 
internal changes have been made to the layouts provided. 

This means that some layouts created by users in RTx 1.0 may no longer display as expected.  

It is strongly recommended to delete any layouts created in RTx 1.0 and recreate them in RTx 
1.5. This can be achieved by: 

1. Navigate to the user’s “My Documents” folder 

2. Open the “Mirada RT” folder 

3. Delete the folder called “Layouts” 

4. Delete the file “defaults.xml” 

5. Navigate to the system’s “Shared Documents” folder 

6. Open the “Mirada RT” folder 

7. Delete the folder called “Layouts” 

These changes will also reset settings for which layout is shown by default when RTx is loaded, 
and which registrations are automatically applied. 

2.1.10 RT-811 Layout editor timepoint configuration 

When creating a layout for a single timepoint in review modes that support multiple 
timepoints, it will not be possible to specify which timepoint is shown for that layout when 
multiple timepoints of data are loaded. 
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If the chosen timepoint is not as expected when this layout is used, use the switch timepoint 
tool or hotkey to change which timepoint of data is displayed. 

2.1.11 RT-789 Project within timepoints not working for regions created on a fused view 

When loading data consisting of multiple datasets, such as gated PET, gated or multi-phase CT, 
multi-sequence MR, etc. it is possible to draw a region on one dataset and project it to others 
within the set using the Project within Timepoint operation. 

When this data is shown as a fused overlay with a static  base layer – for example, multi-
sequence MR as a fused overlay on a static CT, then under the same circumstances the 
projection tool will not be shown as enabled. 

In this situation, it will be necessary to switch to layout where the data is not an overlay to a 
static dataset. At this point it will be possible to create and project the region. 

2.1.12 RT-776 Apparent inconsistency between dose wash, dose lines and iso-dose 
regions 

Small differences can be observed between the dose-wash, filled iso-dose display and the iso-
dose structures if the display is turned to use Nearest Neighbour image interpolation and the 
smooth contours feature is disabled.  

This is a visual effect only and does not affect quantification tools. All quantifications related 
to dose including the DVH are performed on the dose volume at its native resolution. This 
visual effect occurs only on views containing a Planning volume with dose wash and no such 
discrepancy occurs in dose-only views.  

It is recommended that the system is set to show smooth contours with linear or bi-cubic 
image interpolation.  

2.1.13 RT-755 Layers behaviour 

When display a fused or overlay view, the layers panel at the top-left of the display allows the 
user to select on which dataset operations are performed. 

For example the window/level tool, when selected and used within a layout, will adjust the 
window and level of the base or overlay depending which is selected in the layers panel. 

Some region drawing and editing tools apply only to a specific layer, for example when 
viewing Dose on top of CT, region drawing should be peformed on the CT, the base layer. 

If the incorrect layer has been selected automatically by the system, or by the user, the region 
tools may not work – indicated by a specific mouse cursor – or may not produce the desired 
results. 

Additionally, the user should note that any on-screen statistics such as volume are displayed 
only for the selected layer. 

It is important to check which layer is selected when creating or editing regions on fused or 
overlay views. 
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2.1.14 RT-650 Quick Step of Atlas Contouring with Export not possible 

RTx allows creation of quick steps to combine multiple operations as a single quick step action. 
Amongst the operations that can be added to quick steps are atlas contouring and an export 
of selected structures. 

In this version of the software, it is not possible to define a single quick step that performs 
both an atlas contouring operation and a subsequent export of the selected structures. This 
can only be achieved as two separate quick steps. Alternatively, a quick step can be created to 
perform atlas contouring and export all of the created structures. 

2.1.15 RT-413 Manually applying loaded superfine registrations 

RTx permits multiple registrations to be saved against a pair of datasets, and reloaded at a 
later time. From the Registration Manager, it is possible to select any of the loaded 
registrations and re-apply them to the loaded data. 

Applying a loaded registration does not show any progress information and the application 
may not respond to further mouse or keyboard operations whilst the registration is applied. 
This is normally a quick operation and will not be noticeable but may, in the case of a ‘super-
fine’ CT registration, take several seconds. 

Once the operation has completed, the system will be fully operational. 

2.1.16 RT-224 Data QC for Multiple RT Dose Volumes in the Same Series 

If the Data QC feature is used on multiple RT Dose volumes that are part of the same series, 
then the attributes are only read from the first Dose volume read, rather than each Dose 
volume in the series. To work around this issue, it is recomenended that Dose volumes are 
created as one volume per series before loading into RTx. 

2.1.17 RT-211 Out of memory on exporting Enhanced CT 

RTx may report an out of memory error when exporting Enhanced CT as original data. 

There is no workaround to this issue within RTx. The Enhanced CT data loaded into RTx must 
be transferred to the destination by some other means. 

2.1.18 RT-210 Error attempting to export resampled Enhanced CT 

RTx does not support DICOM export of Enhanced CT as a resampled volume. Any attempt to 
perform a resampled export of Enhanced CT data will cause this error to be reported in the 
Messages window: 

Uncaught exception on event dispatch thread (IllegalStateException: null) 

There is no workaround to this issue until RTx supports the resample export of Enhanced CT 
data. 

2.1.19 RT-85 Missing RTx icons. 

If RTx is installed alongside Mirada XD product and XD is subsequently un-installed, the RTx 
icons in Application Launcher will not be present. To restore the RTx icons, run repair from the 
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RTx application entry in Windows Control panel/un-install a program. Note: this will need to 
be run from a user account with the appropriate permissions to install applications.  

2.1.20 RT-2 Paint/Erase tools with small brush sizes do nothing in some views 

When painting or erasing a region with the paintbrush size set to be smaller than a voxel, no 
voxels will be painted. This issue can be avoided by increasing the paintbrush size. 

2.1.21 FUXD-2666 Encoding Holes in RT Structure Sets 

RTx encodes each hole within a region as a separate contour when writing to a DICOM RT 
Structure Set. This should be noted when reviewing RTx generated contours on a RT Planning 
system. 

2.1.22 FUXD-2645 Large Secondary Captures may slow down load times 

RTx allows the viewing of secondary capture images. These can include slice ranges, which can 
potentially be very large and affect load times and the amount of available memory. If 
performance is not as expected then these secondary captures should be de-selected before 
launching RTx. 

2.1.23 FUXD-2557 Inconsistent region shadowing when data bindings are changed 

For PET/CT gated data, changing the data bindings after region creation may appear to exhibit 
inconsistent shadowing behavior. For threshold regions, the original shadow remains when 
the data binding is changed in the Data Management screen. When the threshold is edited the 
shadow appears on the new bound data, but is not removed from the old one as it should be 
(nor changed on the old one).  
However when this region is converted to a painted region, using the editing brush, the old 
shadow disappears. 

To work around this issue, it is recommended that any changes that need to made to the 
bindings in Data Management screen are performed before creating regions. 

2.1.24 FUXD-2537 Inconsistent Regions across a deformable registration 

A region created on the overlay layer of a fused view may not visually match an identical 
region created on the same dataset in a non-fused view if a deformable registration is in place 
between the datasets visible in the fused view. 

This is a visual effect only and does not affect the underlying region statistics. 

2.1.25 FUXD-2535 Slice range export can crop the image being exported 

When exporting slice ranges, if the width of the view being exported exceeds the height, the 
image will appear slightly cropped in the preview displayed when exporting the slice range. 
This can be avoided by adjusting the width of the exported image (default 300) to be more 
than the height until the image preview contains all the desired image. An alternative is to 
slightly zoom out the view required before selecting the option to export the slice range. 
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2.1.26 FUXD-2533 MIP Generation displayed when playing Cine with MIP view present 

When playing a cine for gated data with a MIP view on screen, a MIP generation message is 
displayed each time a different phase is displayed causing slow playback of the MIP. This can 
be avoided by selecting a layout that does not contain a MIP view. 

2.1.27 FUXD-2515 Region Statistics Obscured by Cine Slider 

The within-view VOI statistics may be slightly obscured if the cine slider is active in the image 
views. To view the obscured text, disable the cine slider (navigation tools).  A hot key can be 
set to do this in [Tools->Options]. 

2.1.28 FUXD-2499 Transforming Regions Across Deformable Registrations 

Regions transformed across deformable registration may not correspond exactly to the 
transformation indicated by the cross-hairs at all points on the boundary. This is a visual effect 
only and does not affect the underlying region statistics. 

2.1.29 FUXD-2488 Exporting Gated PET Data 

Exporting an original or re-sampled phase from a Gated PET series results in the exported data 
containing the gating related meta-information. In some systems this may result in the data 
appearing to be an entire gated series, whereas it is only one volume. 

2.1.30 FUXD-2340 Paint Tool usage on off-axis views 

When using the region paint and eraser tool, the depth can be set using the depth slider 
control. This depth is calculated from an axis oriented frame.  When the paint tool is used in 
an rotated (off-axis) view, the depth applied to the painting operation may not be as 
expected. To avoid this issue, check the results after painting and adjust the depth as 
necessary when painting in off-axis views. 

2.1.31 FUXD-2045 Goto Ruler created on rotated view 

If a ruler is created on a rotated (off axis) view after which the orientation is changed, when 
the Goto ruler option is selected, the ruler will not be displayed. To workaround this issue, 
take a bookmark after creating the ruler. Double clicking the bookmark will then display the 
ruler. 

2.1.32 FUXD-1379 Some avi files do not play in VLC 

Some avi files created in RTx will not play in all media players, such as VLC. They will, however, 
play correctly in Windows Media Player and Apple’s Quicktime. 

2.1.33 FUXD-1165 No overwrite prompt on saving images to file from the Image Gallery 

When saving Images from the Image Gallery to the file system, no warning is displayed should 
the folder being written to contain files  with the same name as the system generated file 
names. 
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It is recommended that each time images are saved to file from the Image gallery, they are 
written to a new folder. 

2.1.34 FUXD-618 Fused MIPs Degrades Performance When Visible During Registrations 

If a fused MIP is visible when registrations are being computed then each completed 
registration is applied to the Fusion MIP which takes a number of seconds to complete. This is 
most noticeable when performing manual registrations. 

It is recommended that fused MIP pop up window views are closed prior to performing 
registrations and that a layout without a fused MIP view is selected before performing 
registrations. 

2.2 Product Notes 

2.2.1 Atlas Contouring 

If you have used the atlas contouring feature in previous versions of RTx, then please contact 
Mirada Support for assistance in upgrading this feature as the functionality for adding and 
removing atlas files has changed significantly. 

2.2.2 Create Ruler From Region Tool 

The create ruler from region tool creates a bi-ruler (2D ruler) by calculating the long and short 
axes from the region selected. This bi-ruler is always taken from the smooth representation of 
the region. If the region display has been set to display voxel mask based regions, then the 
generated bi-ruler will appear to not exactly match the region. 

2.2.3 Region Intensity Distribution Graph with multiple datasets 

When multiple datasets are loaded into a particular role (e.g. gated CT, Multiphase CT) and a 
region has been propagated from one of the datasets to the others, then the Region Intensity 
Distribution Statistics will be displayed in the image views and the statistics displayed will 
pertain to the dataset for which they are displayed. The Intensity Distribution graph cannot be 
viewed in this case as no individual region can be selected. In addition, the statistics on the 
Intensity Distribution tab on the Findings Table will not be available. 

2.2.4 CT Window and level presets ‘abdomen/pelvis’ and ‘chest’ presets have same 
value 

Switching between ‘abdomen/pelvis’ and ‘chest’ window and level presets for CT datasets will 
appear to make no difference to the image visualisation. 

No workaround is required. For the current release of the software the CT window and level 
presets for these two body parts have been intentionally set to the same value. 

2.2.5 Calculation of SUV 

When using SUV calculation during PET assessment certain assumptions are made with regard 
to the reference time for the acquisition of the data series. Variability in interpretation of 
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requirements outlined in the DICOM Standard with regard to determination of the start 
reference time during acquisition and the time of tracer injection may result in variability in 
the SUV values calculated by different vendors. 

It is important to note that due to inconsistency of approach throughout the industry, the 
acquisition time used in SUV calculation may be any of the acquisition times presented in the 
DICOM data. It is equally important to note that SUV is affected by a number of physiological 
factors which cause variability (ref Von Schulthess, Clinical Molecular Anatomic Imaging, 
Lippincott, Williams and Wilkins, 2003 (ISBN: 0-7817-4144-0), pp. 86-87). Taking these two 
factors into account, SUV can be thought of as a simplified measure of radiopharmaceutical 
uptake which has a complementary rather than directive role in the assessment, treatment 
and staging of disease. 

Note also that SUV calculations will only be possible for datasets that have all appropriate 
information. This includes: 

 data source must be a PET Emission; 

 activity must be expressed in appropriate units (BQML); 

 appropriate decay correction must have been applied; 

 half-life for radiopharmaceutical must be known. 

Should SUV calculation not be possible, the SUV items on the Quantification Settings dialogs 
(accessible clicking on the modality overlays or by selecting Quantification Settings from the 
Image menu) will be marked as Unavailable. 

Versions of the DICOM Standard prior to 2006 specify a Radiopharmaceutical Start Time for 
PET series. This is the actual time of radiopharmaceutical administration to the patient for 
imaging purposes. However, the standard does not specify a date corresponding to this event, 
assuming it is the same date as the acquisition date. In some cases with long half-life 
radiopharmaceuticals, this may not be the case and there would be a need to specify a 
different date should the radionuclide creation date is different from the acquisition date, but 
this situation has not been captured in the DICOM standard. This is a source of ambiguity 
when dealing with datasets with incorrectly assumed radionuclide creation date. 

RTx makes an initial assumption that the date corresponding to the Radiopharmaceutical Start 
Time is the same as the Acquisition Date. This assumption works well, except when the 
acquisition has been performed over midnight. In such cases, the initial assumption will result 
in Acquisition Date/Times which appear to precede the assumed Radiopharmaceutical Start 
Date/Time. If RTx finds that the Acquisition Date/Times appear to precede the assumed 
Radiopharmaceutical Start Date/Time, it adjusts the assumed Radiopharmaceutical Start 
Date/Time by subtracting 24 hours. This correction will work correctly for datasets for which 
dates and times cross midnight, but not in other cases as there is not enough data in the 
DICOM header to assume any other option. 

In summary, RTx will use the Radiopharmaceutical Start Date/Time information in the data if 
present and calculate it as specified above if only the time is present. 

2.2.6 Registration of Hybrid Data with inconsistent frame of Reference 

Some PET/CT scanners are known to create PET and CT data with inconsistent frames of 
reference. RTx will preserve the frame of reference for this type of data (i.e. not register the 
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PET to the CT) as long as the data matches the pre-configured values for this behaviour 
defined in RTx. Please contact Mirada support for further information or to add additional 
scanners to the system configuration. 

2.3 Thin Client Deployment 

This section is only applicable for users that access through the Mirada supplied thin client 
installation. 

2.3.1 FUXD-2669 – Active text control and cine can skip slices 

Using the active text control or the cine play control on the thin client deployment can cause 
RTx not to display every slice. It is recommended that these navigation methods are not used 
if it is required that every slice is displayed. 

2.3.2 Quantization of Colors on Client Systems 

The system is configured to use 32 bit color on connecting to the server. This setting must not 
be changed. Grayscale images displayed on the client are identical to those displayed when 
RTx is installed locally. However, the user should note that there is a minor difference in the 
displayed images of a remote client and a local RTx when using non-grayscale color maps. This 
effect only affects the displayed image and there is no difference in any of the quantification 
values. It is recommended that images are also reviewed using grayscale colormaps. 

2.3.3 Connection to the thin client may take longer on first use 

On connecting a new user to the Mirada thin client server for the first time, it may take up two 
minutes to logon while Windows creates the user’s profile. 

2.3.4 Data storage configuration 

When each user connects to the Mirada thin client for the first time, they may be prompted to 
define or create a data storage configuration if one has not already been defined as part of a 
system-wide configuration.  

2.3.5 Logging onto the Server with the same user account from multiple machines 

Each user should only log onto the Mirada thin client from one location at a time. If multiple 
logons are attempted with the same user credentials, previous connections may be 
terminated and any unsaved work lost. 

2.3.6 Shared Configuration Items 

If any configuration items (e.g. layouts) are created by a user, then they will not be available 
to the other clients until the next time they connect. 

Shared layouts will be picked up by the system and displayed in the Review Modes tab also. 
They will not be available for selection until they are made available for a particular review 
mode. 
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2.3.7 Saving to the File System – Default Location 

If any items are saved from RTx to the file system, it should be noted that the default location 
offered will be to save to the server, not the client machine. As long as the network shares and 
permissions have been configured by IT, it is possible to save to the clients machine directly. 

2.3.8 Fast Layout Switcher does not work as Intended 

The CTRL+TAB method of switching layouts does not display the selector, it simply selects the 
next layout. It is recommended that this method of selecting layouts is not used for this 
deployment. 

 


